## MICROSOFT PowerPoint 2007 (PC)
### Intermediate /Advanced Features

### Part I: Getting Started

2

### Part II: Intermediate-to-Advanced PPT Competencies

- Working With Slide Masters 2
- Repositioning, Resizing, Rotating, Layering, Aligning, Distributing & Grouping 4
- Using PowerPoint’s Image Editing Tools 6
- Inserting Movie Files Into PowerPoint 7

### Part III: More PPT Competencies

- Adding Sound Files 8
- Creating Hyperlinks And Action Buttons 8
- Inserting Charts 9
- Using Connectors 10
- Using Custom Animation On Bullet Slides 11
- Alternative Distribution Methods 13

### Questions?

Helene Hoffman, PhD  
Assistant Dean, Educational Computing  
TEL: (858) 534-3656  
EMAIL: hhoffman@ucsd.edu  
WORKSHOP HANDOUTS http://meded.ucsd.edu/edcom/workshops/
**PART I: GETTING STARTED**

Welcome to the intermediate / advanced class in Microsoft PowerPoint. To begin, please work exercise I below on your own. This presentation will be used as the basis for the rest of this session.

**Exercise I - Create a new presentation**

1. Use **Design** tab (**Page Setup** section) to size your slides for an On-screen show.
2. From the same tab, select your **Theme** and **Theme Colors** or use the **Background Styles** to add a simple background color.
3. Add a title to your presentation.
4. Return to **Home** tab (**Slides** section). Use the **New Slides** pull down menu to add 2-3 more sides.
5. From the **Insert** tab, insert one or more pictures from the Media4PPT folder on the desktop.
6. If you have time, add a few speaker notes in the **Notes Pane**.

**PART II: WORKING WITH DESIGN & LAYOUT TOOLS**

**Employing Slide Masters**

A **Slide Master**, part of the PPT file info, stores:

- Placement of text and objects on a slide.
- Text characteristics (font type, size, color, etc.).
- Line spacing preferences.
- Background (theme, background graphics, etc).
- Special effects (shadows, bullet type, etc.).
- Placeholders for text, headers, and footers.

Presentation created using **Slide Master** look more professional and (once you are familiar with the process) are easier to create. Slide Masters ensure consistency from slide to slide. They enable you to change the appearance of all slides (of a given layout) with a single change on the slide master. Slide Masters are also a handy way to add logos, footers, etc. to every slide.

While all slides in a presentation should have the same unifying theme (whether professional or home made), you can create “sub-masters” for any layout you frequently employ. PowerPoint supports slide (sub) masters for the layouts including those listed below:

<table>
<thead>
<tr>
<th>Title</th>
<th>Two columns of content</th>
<th>Contents with caption</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title and content</td>
<td>Comparisons</td>
<td>Title and vertical text</td>
</tr>
<tr>
<td>Section header</td>
<td>Blank</td>
<td>Vertical title and text</td>
</tr>
</tbody>
</table>
Even though you set up a slide master, not all slides have to follow it in every detail. On any individual slide, you can make changes to any element: the colors, textures, shading pattern, pictures, graphics, headers, footers, etc. You can also suppress the background graphics on any slide, if you so choose.

To **open** the slide master:

View tab -> Click on **Slide Master** (red highlight), and a Slide Master tab will open.

*Note the handout master and notes master can be accessed from here.*

The tools within the **Slide Master** tab provide what is needed to edit the Master: themes, colors, fonts, effects, background styles, etc.

To **close** the slide master: use the **Close Master View** button.

**Exercise II – Slide Masters**

1. Open the Slide Master for your presentation
2. Click on the top (largest) slide icon. This is the overarching Slide Master.
3. Select a Theme or change your background (if you have not already done so).
4. Select the text “Click to edit Master title style” and make changes to the following:
   a. Font style, size, or color.
   b. Title alignment.
5. Select the text “Click to edit Master text styles” and make changes to the following:
   a. Font style, size, or color.
   b. Bullets.
   c. Line spacing.
6. Add a footer, date, or page number (if you desire).
7. Experiment with the sub (format-specific) Slide Masters.
8. When you are done, close the Slide Master menu.
Objects: Repositioning, resizing, layering, aligning, distributing, and grouping

An object in PowerPoint can be clip art, photos, charts, tables, text, etc. Some manipulations can be done directly to an object. Others require tools found in specific Format menu that appear depending on the type of object selected. See the Drawing Tools, Picture Tools and Movie Tools below.

Repositioning does not require any special tools.
1. Click on the object. The cursor changes to a **four-way arrow**.
2. Click-drag the object to the new position.

Resizing:
1. Approximation method.
   a. Click on the object. A **bounding box** with small white circles /squares appears.
   b. Place the cursor over the **circles** (corners) or **squares** (sidewalls). The cursor will change to indicate the direction in which the object will resize.
   c. Click-drag to the new size.
2. Precise method
   a. Click on the object.
   b. Enter the values for height and width in the **Size** section of the Format tab.

Rotating:
1. Click on the object.
   a. Place your cursor over the green dot that appears at the top. It will change to a **rotate cursor** you can use to turn the object.
   b. Or use the **Rotate** menu from the **Arrange** section for the Format tab.
2. When you are done, click outside the object.

Layering: The object most recently added to a slide is placed on top, the oldest at the bottom.
1. Select one or more objects on the slide.
2. Use the choices in the **Arrange** section for the Format tab.
   a. Bring to Front or Bring Forward
   b. Send to Back or Send Backwards
Aligning the edges of multiple selected objects:
1. Hold down shift key and click each object you want to select.
2. Click on the Align pull down menu.
3. Make sure **Align Selected Objects** is selected.
4. Choose **Align Left, Center, Right, Top, Middle, or Bottom**.

Aligning one or more objects relative to the slide:
1. Select the object(s).
2. Click on the Align pull down menu.
3. Make sure **Align to Slide** is selected.
4. Choose **Align Left, Center, Right, Top, Middle, or Bottom**.

Distributing with 3 or more objects to make them equally spaced (horizontally or vertically) with respect to each other:
1. Hold down shift key and click each object you want to select.
2. Click on the Align pull down menu.
3. Make sure **Align Selected Objects** is selected.
4. Choose **Distribute Horizontally** or **Distribute Vertically**.
5. This action keeps the outer objects stable and moves the inner ones for equal spacing.

Distributing with one or more objects to make them equally spaced across the slide:
1. Select the object(s)
2. Click on the Align pull down menu.
3. Make sure **Align to Slide** is selected.
4. Choose **Distribute Horizontally** or **Distribute Vertically**.

Grouping creates a collection of objects that behave as one.
1. Select the objects.
2. Pull down the Group menu.
3. Select **group, ungroup, or regroup**.

*Note: sometimes the Group menu is grayed out and unavailable. Often this is because the objects have been inserted into a placeholder. The easiest option is to copy the images to a clean slide and try again.*

**Exercise III - Manipulating Objects**
1. Take a few minutes to work with the objects in your presentation.
2. Try repositioning, resizing, layering, aligning, distributing, and/or grouping.
Using Image Editing Tools

Basic image editing can be done within PowerPoint. When you click on an image, the Picture Tools-Format menu Ribbon (above) will appear.

**Image fine-tuning** options are found under Adjust:
1. **Brightness**.
2. **Contrast**.
3. **Recolor** (includes Set Transparent Color).
4. **Compress Pictures** (includes some useful options to reduce file size, such as deleting cropped area of pictures).
5. **Change Picture**.
6. **Reset Picture**.

**Cropping** tool is found under Size:
1. Click on the object.
2. Select the crop tool.
3. The cursor changes to a crop symbol.
4. Drag the special frame edges of the picture until the desired effect is obtained.
5. When done, click anywhere off of the object.

**Image embellishments** can be added through options under Picture Styles
1. Shapes
2. Borders
3. Shadows
4. Glows and soft edges
5. 3D rotations

**Exercise IV - Image Editing and Layout**

Take a few minutes to explore the variety of editing options and apply them to your images.
Inserting Movie Files

<table>
<thead>
<tr>
<th>File Format Supported in 2007</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Video file - AV interleave</td>
<td>.avi</td>
</tr>
<tr>
<td>Motion Picture Experts Group</td>
<td>.mpg or .mpeg</td>
</tr>
<tr>
<td>Windows Media Video</td>
<td>.wmv</td>
</tr>
<tr>
<td>QuickTime (must be installed)</td>
<td>.mov</td>
</tr>
</tbody>
</table>

**Note:** Inserted movies are **linked** to your presentation, unlike pictures that are **embedded** in the PPT file. Therefore, **you must carry a copy of the movie with the PowerPoint presentation** or it will not work when you move the presentation to another computer.

**My suggestion:** Before you insert a movie:
1. Make sure the presentation is located inside of a folder.
2. Find the movie and copy it to the same folder.

**To insert** movie / video file

1. Select the file:
   a. From **insert tab**, select **Movie** from the **Media** section.
   b. Locate movie title in the file menu, and then click **choose**.
2. A message appears.
   a. Click **yes**, to automatically play movie when you display the slide in a slide show.
   b. Click **no**, to play movie only on mouse click.
3. To preview the movie
   a. Double-click the movie.
   b. Click the preview button on the **Play** section of the **Movie Tools** Ribbon.

To modify movie options, use the **Movie Tools – Options Ribbon**.

**Exercise V - Inserting movie files into your presentation:**

1. Select one or more of the movies located on the Workshop folder located on the desktop of your computer. (Look inside a folder called “Media 4 PPT class” for a folder called “Movie files”).
2. Copy the file to the folder that contains your working presentation file and follow the instructions for inserting a movie.
3. If you have time, try to modify some of the movie options.
PART III: USING OTHER POWERPOINT FEATURES

Adding Sound Files

<table>
<thead>
<tr>
<th>Supported File Format in 2007</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Interchange File Format</td>
<td>.aif or .aiff</td>
</tr>
<tr>
<td>Musical Instrument Digital Interface</td>
<td>.mid or midi</td>
</tr>
<tr>
<td>MPEG Audio Layer 3 file</td>
<td>.mp3</td>
</tr>
<tr>
<td>Windows Audio file</td>
<td>.wav</td>
</tr>
<tr>
<td>Windows Media Audio file</td>
<td>.wma</td>
</tr>
<tr>
<td>QuickTime (must be installed)</td>
<td>.mov</td>
</tr>
</tbody>
</table>

Note: Some sound formats (such as mp3, aif and midi files) and those with a file size larger than the size set in your Preferences, are not embedded (they are linked). So, before you insert an audio file, make sure the presentation is located inside of a folder the audio file is copied to the same folder.

The steps for inserting audio files are the same as video files. Once an audio file has been added to your slide, a speaker icon appears. It can be moved to any convenient location on the slide. To preview the sound, double click the icon.

Creating Hyperlinks

1. Highlight the text to be linked.

2. Click on the Hyperlink button on the Insert Ribbon.

3. Dialog box opens with multiple options including:
   a. Linking to a website
   b. Linking to an email address
   c. Linking within the PPT

Using Action Settings

1. Similar to hyperlinks
2. Also includes other options:
   a. Run a program
   b. Play a sound
   c. Use rollover or mouse click
Inserting Action Buttons

1. From the **Insert Ribbon** and choose **Shapes**.
2. Select an **Action Button** or choose another shape and create one yourself.
3. Draw your button
   a. Click somewhere on the slide to get the default size/shape button
   b. Or drag it across the slide to draw the button of a different size/shape.
4. The **Action Settings** dialog box will appear. Make your selections as outlined above.
5. To change the button design, use the **Drawing Tool – Format** Ribbon.

Adding Charts

PowerPoint 2007 uses Excel to create charts within the presentation.

1. On the **Insert Ribbon**, click **Chart**, and a dialog box will open.
2. Click on a category, and then select the specific chart type you want to use.
3. Excel opens with a table of sample data.
   a. Replace the sample data with your data.
   b. Or copy your data & paste over sample data.
4. The chart data is automatically saved with the PowerPoint and cannot be saved separately in Excel.
5. If your chart is already in Excel, then you **copy and paste special** into PowerPoint. Paste as “Microsoft Excel chart object”.
6. The **Chart Tool** Ribbon provides options for organizing and displaying your data.
Using Connectors

There are three types of connector lines to join objects:
1. Straight
2. Elbow (angled)
3. Curved.

Each comes with /without arrows at one/both ends. The elbow and curved connectors have yellow diamonds that can be used to modify their path. To move the line, hold onto the yellow diamond and click-drag.

These connectors can be accessed 2 ways:
1. From the Insert Ribbon – under Shapes
2. From the Drawing Tools Ribbon – under Insert Shapes

Select a connector from the menu. Then roll cursor over shape. A red connection sites appears. These points indicate where you can attach a connector.

When a connector is correctly attached to a shape, the connector site turns red. It is locked.

If you move objects joined by locked connectors, the lines stay attached to the object. This is only true while you are in the Normal View, designing your slide. Unfortunately it is not interactive during a Slide Show.
Custom Animation

1. To have bullets appear one at a time (on mouse click):
   a. Click inside text box of the bullet (or numbered) list; a bounding box will appear.
   b. Open the Animation Ribbon.
   c. The Animate pull down menu (highlighted in red) is by default, set to No Animation.
      i. If you want each line of text to appear, you can select one of the options.
      ii. “By 1st level paragraph” will do each major bullet, one at a time.

2. To have bullets appear and the old ones fade:
   a. Select Custom Animation and the screen changes to provide additional tools, including a Custom Animate box on the right (outlined in red).
   b. Entrance: Because we already selected the bullets to appear with a fade, that information already shows up in the Custom Animate as a green star labeled Content Placeholder. Below it are two downward arrows. Click on the arrows to expand the list. Each of the bullet lines has its’ own green star (the icon for entrance) and a mouse (the icon for mouse click).
c. **Exit:** Click on the **Add Effects** pull down menu and choose **Exit** *(a red star).* Then pick the **Effect.** There are other choices (including fade) on the **More Effects** page. Go to **Modify: Fade** *(or whatever effect you chose).* Make the **Exit Effect “Start With Previous”**. Pick any **Speed** you desire. Now click on the double arrows and expand this second placeholder.

d. PowerPoint executes these directions in order. Preview the animation now and you will see each line appear (one at a time) followed by everything fading at once. That is not what you want.

e. The order of these directions must be changed. To do so, click on a line, then use the **Re-Order Up and Down Arrows** to weave the red stars in between the green stars to create the correct event order. See the example on the left.

f. Unless you want to end with a blank slide, you have a “Kiwi fades” that does not get used. Delete it using the **Remove** button *(top of box).*

3. Another option is to use **Emphasis (yellow star)** menu instead of **Exit.** If you select a grey or low contrast color, the bullet is de-emphasized but still visible.
**Alternative Distribution Methods**

In addition to saving your presentation as a PowerPoint file, there are a number of other useful options available. Below are a selection of some of the common methods of saving and sharing your work.

1. **From the Save-As menu (Office Button)**

| PDF | PDF presentation will look the same on Mac and PCs. Preferred method of saving and distributing presentations used in the UCSD curriculum. |
| Webpage | Can be run locally or published to the Internet. If you do not publish, it will still play with a browser and is handy for users that do not have the Microsoft Office applications. |
| PowerPoint Show | Presentation that only opens in slide show view. |

2. **From the Send menu (Office Button)**

| e-mail | PowerPoint files can be sent as attachments via email. But be aware of file size that can be excessive. |

3. **From the Publish menu (Office Button)**

| Package for CD | Automatically collects sounds, movies, and other linked files that are not embedded in the presentation and creates a new folder that contains all the linked files along with a copy of the presentation. The PowerPoint Package is a copy of the presentation and its linked files – in a location specified. The original presentation and linked files are in the original location. |
| Publish slides | Saves slides to a slide library |
| Create Handouts in MS Word | Open the presentation in MS Word and create custom handouts. |